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About ScribeDOOR

ScribeDOOR adds the ability to edit and treat text in a
wide range of languages: Arabic, Azeri, Bengali, Farsi,
Georgian, Greek, Gujarati, Hebrew, Hindi, Kannada,
Kazakh, Khmer/Cambodian, Lao, Malayalam, Marathi,
Oriya, Punjabi, Tamil, Thai, Urdu, Viethamese and
Roman languages (English, French, ...).

ScribeDOOR can be installed in all Roman InDesign

versions (English, French, Italian, Czech, Polish,...).

In localized user interfaces (except French), only the
English user interface will be available for ScribeDOOR
panel and tools.




Activation process

*  When launching Adobe InDesign after installing
ScribeDOOR for InDesign, the following dialog is displayed.

* You have the choice to enter your license (serial number)
and then to activate ScribeDOOR (only available with FULL
version, not Trial version).

* You can also use ScribeDOOR for 7 days in trial mode. In
trial mode, a Welcome Screen will be displayed at each
launch of InDesign.

+ To activate ScribeDOOR, enter your serial number and click

on “Continue”.

WinSoft ScribeDOOR 2026 for InDesign

Welcome to ScribeDOOR 2026 by WinSoft International

Thank you for installing ScribeDOOR 2026. Here you may choose to
activate ScribeDOOR or simply try the time-limited version.

© | have a serial number and want to activate ScribeDOOR 2026 now

Your serial number is written on your ScribeDOOR 2026 license
certificate.

© I want to try now

There are 7 day(s) left in your trial perlod. When it ends, you must
activate ScribeDOOR 2026 to continue using it.

Need a serial number?
Buy

Buy one online using your web browser

Cancel

« If your trial version has expired, you can display this
window from menu ScribeDOOR by selecting Activate

ScribeDOOR (Note: The trial version can't be activated).

ScribeDOOR  Help

ScribeDOOR Attributes

Selection Helper
Reverse Layout...
Apply Adobe World-Ready Composers

Insert Special Character >

Activate ScribeDOOR...

Help
About ScribeDOOR...



ScribeDOOR attributes
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Contextual menu of ScribeDOOR Attributes
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ScribeDOOR Attributes
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Setting defaults

You can set default parameters which will be applied for any
text frames you create. The following example shows how to
set the 3 attributes listed below:

+ WorldReady Paragrah Composer

+ Right-to-left paragraph direction

+ Naskh justification

1. Close all the InDesign opened documents

2. Open Type> Paragraph style palette, double click on Basic
Paragraph and select ScribeDOOR Paragraph Format

Paragraph Style Optlons

Ceneral Style Name:

Basic Character Formats Location:

Acvanced Character Formats ScribeDOOR Paragraph Format

Indents and Spading

Tabs Composer:  WorldReady Single-Line compaser
Paragraph Rules Paragraph Direction: > ¥4

Paragraph Border
Paragraph Shading

Justification: | Standard (No Kashida insertions)

Kashida width: |2
Keep Options

Hyphenation

Justification

Span Columns

Drog Caps and Nested Styles
GREP Style

Sullers and Numbering
Character Colour

OpenType Features

unceriine Options
Strikethrough Options

Export Tagging

ScribeDOOR Paragraph Format
ScribeDOOR Character Format

(’7 Cancel ;

3. Select the attributes

+  WorldReady Paragraph Composer
+ Right-to-left paragraph direction

+ Naskh justification

and click on Ok

4. For all new documents, these settings will be applied by
default.




Working with complex scripts

In Windows, support of complex scripts is included in standard
installation.

In Windows XP, you must verify the option “Install files for
complex scripts and right-to-left languages” in Supplemental
language support. You have to add this option if you want to
enable Arabic, Hebrew, and South Asian languages on your

System.
S
Formats Administrative

W “¥ Region Settings X

¢ Select which language (system locale) to use when displaying text in
programs that do not support Unicode. This setting affects all user
accounts on the computer.

Current system locale:

English (United States)

La
1 Beta: Use Unicode UTF-8 for worldwide language support

C
014 Cancel

Ry
English (United States)

e e e — - ———— - g——

¥ Change system locale..

0K Cancel

In Macintosh, due to a system limitation, the primary

language in system preferences>international or Language
and Text (Snow Leopord) must be other than Arabic, Hebrew or

Farsi. 7



Installing a language keyboard
Whether you are working in Mac OS or Windows, you need to

install the required keyboards for the languages you want to
work with in Adobe InDesign in your Operating System.

: r
(- Text Services and Input Languages == Text Services and Input Languages [==]
P guag
General | Language Bar | Advanced Key Settings | : General Language Bar | Advanced Key Settings
Default input anguage Defaidt innit lanauace ‘
?jﬁsg«:aﬂhe installed input languages to use as the default for all . Add Input Language @
[Fren ch (Frarce) - French = Select the language to add using the checkboxes belowr. O
[ Arabic (Yemen) B _

Installed services [#- Armenian (Armenia)
Select the sewvices that you want for each input language shown in the [#- Assamese (India) EViEW. ..
lit. Use the Add and Remove buttors to modify this list. [+ Azeri (Cyrillic, Azerbaijan)

[+ Azeri (Latin, Azerbaijan)

& KE)?:Oardh = [+~ Bashkir (Russia)
« Frenc [+ Basque (Basque)
m ﬁe:brem(lsmel) [#)-Belarusian (Belarus)
= Key.:’;rd () Bengali (Bangladesh)
. rew =k Keyboard]|
] [=EKeyboard
i Hungarian (Hungan) i [JBengaii
= Keyboard [T]Bengali - INSCRIPT (Legacy)
= Hungarian Poperties [[us

1

[ Turkish (Turkey)

i [T]show More...
&y Keyboard

[#]- Bengali (India)

» Turkish F = [+~ Bosnian (Cyrillic, Bosnia and Herzegovina)
[+]- Bosnian (Latin, Bosnia and Herzegovina)
[+]-Breton (France) 2
< m 3
OK [ Cancel Appl — e

ScribeDOOR adds the following keyboards in Mac OS: Khmer, Lao,
Sinhalag, Urdu, Telugu. These keyboards can be displayed in
system preferences>international or Language and Text (Snow
Leopard).

Mac OS adds support for Kannada, Telugu, Bengali/Assamese,
Malayalam, Sinhalg, Oriya, Lao, Khmer and Burmese. So, on Mac
OSX, ScribeDOOR installs only Lao keyboard.




Delay until repeat
7 ' } « ' " | § + q
ot
EWW Press fn key to Do Nothing &
Desktop & Dock
nm Use keyboard navigation to move focus between contrals. Press the Tab key
- 1o move focus forwards and Shift Tab to move focus backwards.
ﬁm&w
. ‘ . Keyboard Shortcuts..
Wdlplp.r
 Textinput
Input Sources
£l sound
(9 Focus
Dictation
) Lock Screen
b 7 @, Use Dictation wheraver you can type fext. To start d g, use the shortcut (10
GM‘M P or select Start Dictation from the Edit menu,
ﬂmm
Users & Groups
(@ et Accors
@ Game Center Shortcut Press Control Key Twice £
) Wallet & Apple P '
.‘ by About Ask Siri, Dictation & Privacy...
Set Up Keyboard...
&

Browse using language and select an input source to add:

English ] N asc

French ABC - Extended
Czech ABC - India
Lithuanian Australian
Turkish British

Russian British - PC

Polish

Ainu
Akan
Albanian .
Amharic

asdfghijkl ;"'\
zxevbnaom, . |

[Q ' carch ] Canonl Add




Font considerations

Ensure that you choose an appropriate font in the Font
submenu of the Type menu or in the font pop-up menu of the
Character or Control Palette of InDesign. An appropriate font
means a font containing the character of the language in
which you would like to type. ScribeDOOR installs WinSoft Pro

which supports Roman, Arabic or Hebrew.

You may also use the following fonts :

Platform Arabic Hebrew
Windows + Traditional Arabic « Ahroni
+ Simplified Arabic + David
+ Arabic Transparent * FrankRuehl Regular
+ Simplified Arabic or + Levenim MT or multiscript
multiscript fonts like Arial- fonts like Arial- Times
Times New Roman New Roman
Macintosh « Geezah Pro + Arial Hebrew

+ Baghdad + Corsiva Hebrew
+ Al bayan * New Penim MT
* Raanana
South Asian fonts

For each language, appropriate fonts must be installed.

Below is the list of fonts that can be used with each language.

We remind you that the best results will be given with fonts

provided with Windows.

Thai Angsana
Lao Dok Champa
Devanagari Mangal
Bengali Vrinda
Gurmukhi Raavi
Gujarati Shruti

Orya Kalinga
Tamil Latha
Telugu Gautami
Kannada Tunga
Malayalam Kartika
Tibetan Microsoft Himalaya
Khmer DaunPenh

10



Sample text in South Asian languages

Thai: mulnog

Lao: Usctn02920

Hindi: fgeer scamie|
Bengali: IR O
Gurmukhi: IFAASHS
Guijarati: 24l UBL ‘@'bn
Oriya: QIYQ 21V QUS|
Tamil : QIFTEIT6TTT6L
Telugu: @ResyocovTOT(Oy
Kannada : &e0d3=0eNw0
Malayalam: 6g 1 2]68R80W 1@ 18663
Tibetan: Eﬁ‘@rﬂ

Khmer: (a:ntamsynnym - fadm

WorldReady Composer

Giving access to the “WorldReady Composer” is one of the key
features of ScribeDOOR.

It uses WRServices technology (a component developed by
WinSoft International) which was integrated in most Adobe
products for the Arabic, Hebrew and Farsi languages.

The default Composer (Adobe paragraph Composer) only

supports Roman, Central European, Greek and Cyrillic scripts.

With WorldReady Composer, you will have the ability to type

in complex languages like Arabic, Hebrew or South Asian

languages (Hindi, Telugu, Lao, Thai, ...).

WorldReady Paragraph Composer supports also the same
languages as Adobe Composer. If you try to type Arabic or

Hebrew text with Adobe Composer, it will not work correctly.




How to apply WorldReady Composer
You have the possibility of either converting all of the text frames

of an existing document or working at the paragraph level.

Apply WorldReady Composer for all text frames

Select “Apply Adobe World-Ready Composers” in the contextual
menu of the ScribeDOOR palette. You will now be able to type in

complex script languages in any text frames of your document.

>
ScribeDOOR Attributes

Binding Story Reverse Layout...
a B SR Apply Adobe World-Ready Composers
Paragraph Insert Special Character >

WorldReady Single~Line composer v
Justification: | Standard (No Ka... | v Activate ScribeDOOR...
»q ¥« Kashida width: 2 Help
Character About ScribeDOOR...
Direction: Default
Digits: | Default
Kashidas

Diacritic Positioning: OpenType (... v

X <o v Y iCio |~

Apply WorldReady Composer for a paragraph
If you are in a normal text frame, you can switch any
paragraph to a WorldReady Composer paragraph. Select the
paragraph you want to convert and select WorldReady

Paragraph Composer in the Composer pop-up.

this 1s a roman text frame, it typing arabic,]|
the result is wrong.
text is not contextualized:

ScribeDOOR Attributes

Story

Sinding

q

U‘Jg”a,s-; i
Applying WorldReady composer:

O sardll

dy Paragraph compossar v

von: Standard (No Kashida ... v

Note:

Refer to section «Setting defaults» to apply WorldReady

Composer by default.



Setting up a document

Creating right-bound or left-bound documents
In most text publications, documents are bound on the left.
Conversely, in an Arabic or Hebrew text publication, the binding is
on the right edge of the document. With ScribeDOOR you can

create a document in which the pages are bound on the left edge
or on the right edge.

ScribeDOOR Attributes

Cormrs

Binding

Ty
mnm

v WGy ¢ B SPN COMPOSST

Pages Palette — Page Icons Display

+ Right-bound publication

If your publication is right-bound, as in a Middle Eastern
publication, the page selection icons will be displayed in the Pages

Palette, as in the figure below.

* Left-bound publication
If your publication is left-bound, as in a Roman Publication, the
page selection icons will be displayed in the Pages Palette, as in

the figure below.

Right-to-left binding Left-to-right binding



Page and chapter numbering

Page Numbering now includes new formats for Arabic, Hebrew
and South Asian languages.

You can choose to apply standard, Arabic (Arabic Abjad and
Arabic Alif Ba Tah), Hebrew (Hebrew Biblical Standard and

Hebrew Non-Standard Decimal), as well as South Asian styles.

Numbering & Section Options

© Automatic Page Numbering
:
() Start Page Numbering at:
Page Numbering
Section Prefix;
Style: 1, 2, 3, 4...

Section Marker:

[ Include Prefix when Numbering Pages

Document Chapter Numbering
Style: 1, 2, 3, 4... v

© Automatic Chapter Numbering

() Start Chapter Numbering at: 1

Previous Document in the Book

Book Name: N/A

14



Paragraph humbering

Paragraph numbering includes the same new format as page
and chapter numbering:
Select Bullet and Numbering in the contextual menu of the

paragraph palette.

© Automatic Page Numbering

() Start Page Numbering at: | 1

Page Numbering
Section Prefix:

Style: 1, 2,3, 4...
Section Marker: ?
01,02,03...
001,002,003...
0001,0002,0003...
A, B,C,D..
Bengali Digits...
Devanagari Digits...
© Automatic Cha Farsi Arabic Digits...

[l Include Prefix

Document Chapte:

Style: 1,2, 3,4...

) Start Chapter Gujarati Digits...
Gurmukhi Digits...

Pre

Hindi Arabic Digits...
Book Name:N/A |y i v...
Kannada Digits...
Khmer Digits...
Lao Digits...
Malayalam Digits...
Orlya Digits...
Tamil Digits...
Telugu Digits...
Thai Digits...
Tibetan Digits...
a,b,cd.
i, i, i, ...

15



Footnote humbering

Footnote numbering includes the same new formats as page

and chapter numbering.

Numbering

Style: |1, 2, 3, 4...
Start at: Bengali Digits...
Gurmukhi Digits...
Gujarati Digits...

[l Resta

L1 Stiow Oriya Digits...

Kannada Digits...
Tibetan Digits...
Malayalam Digits...
Farsi Arabic Digits...
Hindi Arabic Digits...
Footno' |30 Digits...
Thai Digits... \pply Superscript ¥

Formattir

Telugu Digits...

Footno:  Tamil Digits...

Devanagari Digits... Basic Paragraph] v

A . :
01,02,03...

001,002,003...

a,b,cd.

A, B, C, D..

b P . T [

I, 1, il Iv...

LR | R | 1R ¥

16



Paragraph direction

It is important to understand and differentiate between

“paragraph direction” and “paragraph alignment”.

+ "Paragraph direction” controls the order of text and neutral
characters (punctuation) inside a paragraph.

« "Paragraph alignment” controls the placement of the whole
line in reference to the left and right boundaries of the text

frame.

Paragraph direction and alignment are independent of each
other. For example, if your text is in Arabic, Hebrew, Syriac,
Thaanaq, Azeri, ... etc, use a “Right-to-Left” paragraph direction,
otherwise, use the “Left-to-Right” paragraph direction option.

The paragraph direction can be set with the paragraph
direction icon in the ScribeDOOR palette. To see how the “Right-
to-Left” option affects the appearance of the text, read through
the following examples.

ScribeDOOR Attributes

Binding Story

v/ Kashidas

Diacritic Postioning:  OpanType 3. |w

X 5 EEEEY v 5 Y

17



Examples of paragraph direction applied to Arabic or Roman text

»Y Y«

Left-to-Right paragraph
direction applied to Roman
text: The alignment is correct
and neutral characters are
correctly situated. The Arabic
text is correctly situated inside
the Roman text.

The lemon o520l is the common
name for Citrus limon. The
reproductive tissue surrounds
the seed of the angiosperm
lemon tree. The lemon is used
for culinary and nonculinary
purposes throughout the world.

When applying the wrong settings

PYl Sl

The text is not aligned correctly,
and the flow of text is right-to-
left. As a result, the punctuation
and the text in Arabic are
incorrectly situated.

is the (0s2UThe lemon (
common name for Citrus limon.
The reproductive tissue
surrounds the seed of the
angiosperm lemon tree. The
lemon is used for culinary and
nonculinary purposes throughout
the world.

L A L

Right-to-Left paragraph
direction applied to Arabic text:
The alignment is correct and
neutral characters are
correctly situated. The Roman
text is correctly situated inside
the Arabic text.

Og-e=ll (Lemon) dlile ) -adis 803
aio el glydun  JSUAT duglias ul...a.oJJ
oSe Jolo a.Lc] R 0953 daledl o ”.o...Ul

oseldl 3lie L..»‘,.u,L..a] 1 g0 adl Juas

P!Mx‘ eLno h_..l...“, s)?“'ﬁ'l'" e QML'»
pasnin pgaalll ol I LLoXL Fudadl b

Jio algpil! yaey I dg Sl ut..ay

= X} 9' (o.)l.vg.a...l.") '...,,.m.a

»4 S«

The text is not aligned correctly,
and the flow of text is right-to-
left. As a result, the punctuation
and the text in Arabic are
incorrectly situated.

og-elll (Lemon) cluaed! dlle I aiil 50l
‘.,J Ogealdl &5 el £l ytun J.Lqu u,LA..;
PdJ'JAJJ'Q&JQ.b\,.Lclh)..MU,L daledl
S9aaddl yuacy .yl ol §lie L..:_,A.a sl 1
Al ALYl Fudadl b plascawX] bl ol
oAty I dg Sl dla¥ pasiiau peasdd! ol
(DJL’ ')de.o.a-l-" u’).nuoéj-n-o uL»g)-m.“
TR T
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Table direction

Table direction defines the order of the columns in a table as
well as the paragraph direction.

When switching to right-to-left, the cursor is automatically
inserted in the top right cell of a right-to-left table. Pressing the
tab key will move you from the top right cell to the cell in the
same row but to the left. Also, the right-most column of the
table gets treated as the first column of the table.

In a left-to-right table the cursor automatically gets inserted in
the top left cell of the table. Pressing the tab key will move you
from the top left cell to the cell in the same row but on the right
of it. Also, the left-most column of the table gets treated as the

first column of the table.

ScribeDOOR Attributes

Binding Story

Parsgraph

Left to Right

WoridReady Paragraph composer

Right-to-left table

4 3 2

Left-to-right table

19



Story direction

A story is any individual text frame or set of threaded text

frames. The story direction only affects the order in which

multi-column text flows. This option will be set for the whole

story even if the story is split into multi-thread text frames. The

“Story Direction” must be set to Right-to-left for Arabic and

Hebrew and vice versa for Roman text.

ScribeDOOR Attributes

Binding Story

o B

Left to Right

I Ve ey aieeSPh COMposer

Arabic text with default Right-to-Left story direction

3
J)Jn, Slggunsl i.o,l-i-o,
au.i..r.!l, .:ol}l.i.”’ o'a.g.n"
Layo paaaddl iy ,dugall
3 - n w' ' & 'y . 1 I |’
Lebio gl Lezudo LS ¢lgn

2

was¥l Cauyig rayddly eyt
avalbas 509 A ¥l ©ua iy
oaalyg T3l e 0ybys Lins]
Gl e aclis dugunc
huogs 13 ,c)l.m, wlaaldl
pupaidly piailog,dl ¥l V.b
vib_pu’ asall &u.i,',
Ll 3y Hlgatly Lgaluasiy
LoS dalidl decasll p¥¥ly
glad)ly od! b Joaian
Jaadl 1l b aiag By, s

If the wrong story direction is applied

1
slgll @al po 7 ol puiay
Aogy il yoye o dudledl
olhas dagds Ao Jons LoS
wdugoadl ducyX!
Sl £lgaS paeulll Joiaw
1rdsSILS ol yo¥lg dlag¥T (10
ouyiidly piilag)lly suigdailly
2SI o poly dsgall GLLYlg
Jlaudly [j59la5%lg
JlsS A ado paaullly
Saguind by Lglogdang oliawXl

2
aidl asiig c”.&", C”J-'
aailas O -y | (Sl 339
oaslgg T30l ALe 0ydgs Linl
3yt le acbus dsganc
huogy 13J 73Xy A laasdl
ourdilly pribogl S¥Ls b
q.'-l.a_,.n.‘u." sl glis,ly
Ll 3,29 gty Lgalaady
LoS dalidl doasll p¥¥ly
&L&J)l’ \,-4-‘“ q’-D J-Q-I—'-Au-g
Jadl y1500 N?'. g 8y, do

]

sldl @al o 7 ralinh puiay
Aogay ¥l pioys (po dadlel
Ohas dugdi Ao Jouy oS
wdugostl decg¥l

LS £1gaS paonlll Joniin
1rteSILS iolyo¥ly Alsg¥l (o
ouydidly piuslogylly sudeduilly
2SI it oty dugall cLLis¥lg
Jladly 135eLas¥lg

Sl b ado gaallly
Saouins by Lglogdaug ol ¥l

3
3ydog wlogunill dogliag
wliasilly oljladly Hlauadl
Lgyo paoulll yuiasg ,dsgall
B
Lilio ol Lasdo LS glgn
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Character direction

InDesign automatically calculates the default character
direction for the paragraph direction as well as to the
surrounding characters according to the language and/or
script of the character you have defined in the InDesign
character palette.

In some very limited cases, some characters may not display
in the right position. Positioning the Right-to-Left or Left-to-
Right character direction in the character palette, in order to

force the direction of the misplaced character, will correct this.

Character
Direction: | Default

Digits: ~ Default
Left-to-Right

Right-to-Left
Diacritic Positioning: QOpenType (... | v

X (S0 v Y: i1Sl0 | v

Justification for Arabic

When working on full justified Arabic text, you can choose
seven types of justification: Standard (No kashida), Arabic
(Legacy), Justification Alternates (Naskh), Stylistic Flat
Kashidas, Stylistic Kashidas, Flat Kashidas, Kashidas — allowing
you the creative freedom to choose the settings that give you
the best results.

- Standard (No Kashida)

Refers to usage of inter-word and inter-character spacings
specified for the Paragraph Style Sheet to get justified
paragraphs. In case ScribeDOOR is not able to justify the

paragraph with the settings in the Style Sheet, it will override
them.

A



- Arabic (Legacy)

ScribeDOOR will first try to justify a line with the settings in the
style sheet, after which the extra space left is divided by the
number of character positions that can accommodate a
kashida. ScribeDOOR will add a number of kashidas equal to

the obtained result.

« Justification Alternates (Naskh)

Allows you to apply the Naskh justification rules to any font
whether or not it is a Naskh font. The best results will be
obtained when this setting is used with WinSoft Naskh Pro or
Deco Type Naskh fonts. The results with other types of fonts will

vary.

* Stylistic Flat Kashidas
Similar to style “Arabic (Legacy)” but add kashidas only on
places allowed by the style and not on most of glyphs

connexion.

* Stylistic Kashidas

Apply Naskh justification rules to any font whether or not it is a
Naskh font. Similar to style “Justification Alternates (Naskh)”
but final glyphs or long form of glyph are untouched. Obviously
the best results will be obtained when this setting is used with
WinSoft Naskh Pro or Deco Type Naskh fonts. The results with

other types of fonts will vary.

* Flat Kashidas
Similar to style “Stylistic Flat Kashidas” but number of kashidas
can be not an integer but can be a decimal number of

kashidas.

22



e Kashidas

Similar to style “Stylistic Kashidas” but number of kashidas can

be not an integer but can be a decimal number of kashidas.

These types of justification are representing the width of

kashidas used to fully justify your text.

Justification Types:

« Standard, Non-forced

+ Standard (No kashida)

« Arabic (Legacy)

« Justification Alternates (Naskh)
+ Stylistic Flat Kashidas

+ Stylistic Kashidas

« Flat Kashidas

« Kashidas

e Kashida width

9l Ayl eyl
o A Rl el ol
! g Sl Byl e 2 ol
P L o L P R
ol o WS Rl e ol
ggja\ Ot KLK'J\J Aoyl ] ol,;l
s o W Il el ol

Allows to set a value determining the width of kashidas.

This value could be set from 1to 4 which can represent Short,

Medium, Long or Stylistic width of kashida used to fully justify

your text.

23



Kashidas

Kashidas are a way of elongating Arabic characters and
therefore decreasing spaces between words, giving better full
justification of the text.

Kashidas can be turned on or off with the corresponding check

box.

ScribeDOOR Attributes

o n

. OpenType 3 v

% %

With kashidas
wluaeasll dile ] et 8,5 ¢ gaull
Osaalll &3 .y sl sl siun (S &l & gl
O 0Sae Jsb Yeldpiun (s—S5 Bulall &
Without kashidas
wluaasll dle ] a5 5585 (gl
Osaalll s o olll el ydin (JSCAN & gl
O (San s el piun o685 Baladl &
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] L]
Digits
You can choose the language in which you want your numeric
digits to be typed. The Default setting means that the numbers
will be in the same language as that of the previous character.

Otherwise, you can choose between Arabic, Hindi, Farsi and all

South Asian numbers.

x

ScribeDOOR Attributes

Binding Story
a B

Paragraph
WorldReady Single-Line composer | v

Justification: Standard (No Ka... v
pe) 94 Kashida width: 2
Character

Direction: Default

Digits: | Default

Native

Diacritic Pos
Arabic

Hindi-Arabic
Farsi

X Co

Devanagari
Bengall
Gurmukhi
Gujarati
Oriya
Tamil
Telugu
Kannada
Malayalam
Tibetan
Khmer
Burmese
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Digits for Arabic and South Asian languages

Arabic: 0123456789 Thai: colomc& b8
Farsi: -1 TFFafFVAQ Lao: 006NEEDNQV
Hindi-arabic: -)Tr£01vA4 Devanagari: ©83%4€16¢R

Bengali: 098¢ LAY
Gurmukhi: 0123¥UE9TT
Gujarati: 0123 ¥US9CC

Oriya: o 9N¥ 899

Tamil : 082 h & [ dn 613180
Telugu: ono3waE 20
Kannada: 009av8ee e
Malayalam: o_.00_m.@@M@h
Tibetan: eg2aaus2)4p

Khmer: oommeesncs

Digits can be set by selecting text or defining paragraph or

character styles.

Diacritic positioning

Short Arabic vowels are floating diacritics, written either over or
under the consonants. Therefore, it is important in desktop
publishing that the diacritics be properly placed over the
consonants, both horizontally and vertically.

When using an OpenType font in your layout you have to use
the OpenType setting to set the position specified by the
font’s designer. This setting is recommended for all recent
Opentype fonts.

Whether your font has built-in diacritic information or not, you
can force InDesign to use its own algorithm to position the

diacritics.
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Defining ScribeDOOR attributes
in character and paragraph styles

You can find paragraph style options for both ScribeDOOR
characters and paragraph formats. Like other options, changes
are viewable using the preview checkbox located on the
bottom left of the ScribeDOOR screen.

Paragraph Style Optlons

Genenal Style Name:

Basic Character Formats Location:

Acvanced Character Formats ScribeDOOR Paragraph Format

indents and Spading

Tabs Composer: | WorldReady Single-Line composer
Paragraph Rules Paragraph Direction: »f %4

Paragraph Border

Justification; Standard (No Kashida Insertions)

Paragraph Shading
R Kashida width: 2
Hyphenation

Justification

Span Columns

Drop Caps and Nested Styles

GREP Style

Bullers and Numbering

Character Colour

OpenType Features

uUnceriine Options

Strikethrough Options

Export Tagging

ScrbeDOOR Paragraph Format

ScribeDOOR Character Format

Paragraph Style Options

Genenal Style Name:
Basic Character Formats Locanion:
Advanced Character Formats ScribeDOOR Character Format

Indents and Spacing

Tabs Digits:  Default

Paragraph Rules ¥ Kashidas

Paragraph Border Direction: | Default
Paragraph Shading

Keap Options

Hyphenation Diacritic Positioning: OpenType (adjustment from base character) Y
Justification x 2o 7
Span Columns Vi 0 N
Drop Caps and Nested Styles

GREP Style

Bullets and Numbering

Character Colour

OpenType Features

Underline Options

Stnkethrough Options

Export Tagging

SeribeDOOR Paragragh Format SC ri beq
SeribeDOOR Character Format D OOR

for Adobe InDesign

L] Preview




Insert special characters

The contextual menu “Insert Special Character” gives you the
ability to insert four Hebrew characters (Geresh, Gershayim,
Magqaf, Sof Pasuk) and one Arabic character (Kashida), as well
as a Right-to-Left or Left-to-Right dash. To insert these
characters just select them in the contextual menu of the
ScribeDOOR palette.

A Rupee sign, Armenian hyphen and Unicode markers have
also been added.

ScribeDOOR Attributes

Binding
amn

2 Reverse Layout...
Apply Adobe World-Ready Composers
Insert Special Character » Geresh

Activate ScribeDOOR... Hieeayin

Check for Updates Diegel

Sof Pasuk
Help

About ScribeDOOR... Bashide

Dotted Circle

Left to Right Dash
Right to Left Dash

Rupee Sign

Armenian Hyphen

Unicode Markers >

Usage of ZWJ and ZWNJ within complex scripts.
The Unicode norm defines two special characters, that are
especially useful for complex scripts :
« The ZWJ (Zero Width Joiner, unicode 0x200D)
« The ZWNJ (Zero Width Non Joiner, unicode 0x200C)
+ These two characters have the basic behaviors that are as
follow :
o The ZWJ breaks a potential conjunction. It also acts as

a combining character in cursive scripts.

For instance:

In Arabic, you can get the medial form of a character by

surrounding it with ZWJ :

& becomes - when surrounded by ZWJ
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In Hindi, the conjunct:
h+Y+ol = §ol becomes a1 when a ZWJ is inserted
after the first consonant.
In Telugu, the conjunct:
§+2+Jd=4)becomes&+a+ZWJ+Jd=8Jors+

ZWJ + & + D = &) depending on the position of the ZWJ.

Besides these common usages, Unicode also defines special
usage that are specific to a particular script. For instance, in
Bengali: g + T = ¥ becomes T+ ZWJ + T = TF
o The ZWNJ primary usage is to force the rupture of a
syllable, for instance fésl becomes BT when a ZWNJ
is inserted after the first consonant. The first consonant
is then isolated from the rest of the syllable, allowing

the i matra to come after this first consonant.

The ZWNJ also has a special usage specific to a particular
script. For instance, in Malayalam, @ becomes M@ with the
addition of a ZWNJ.

Usage of ZWS for Thai, Lao and Khmer

For the languages which don’'t use a space character between
words, it is recommended to use the character ZWS (Zero
Width Space, unicode 0x200B) between words to allow the
Composer to work properly and produce correct line-breaking.
This character is usually easily available on the keyboards used
for such languages (for instance the Khmer keyboard provided

for Macintosh maps this character to the space bar).
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Arabic spell checking and
Hebrew hyphenation

In addition to the Western language hyphenation and spelling
available in InDesign, ScribeDOOR adds support for the
following languages. These features are implemented once the

appropriate language is applied to the text.

Languages Hyphenation Spelling
Arabic* X
Hebrew X

* Arabic dictionary Powered By |SIS Arabic NLP Technology

InDesign lets you specify a different language even for a single
character of text. You can customize language dictionaries to
ensure that any unique vocabulary you use is recognized and

treated correctly.

To assign a language to selected text:
In the Character and Control palette of InDesign, choose the

appropriate language in the pop-up.
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Additional features

Selection helper

ScribeDOOR'’s “Selection Helper” is a simple and effective tool
for editing complex text. In this version of ScribeDOCR, this
feature is only available in Arabic, Hebrew and Roman text. By
presenting each letter separately, the selection and
transformation is made extremely easy.

Just move the mouse over the letters you want to select in the

“Selection Helper” palette.

£ Selection Helper

EANONNE - EORDESaD

¢ Selection Helper
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Reverse layout

ScribeDOOR includes a very useful tool to revert/flip the layout
of documents. This option can be used when converting a Left-
to-Right document (Roman) to a Right-to-Left one (Arabic or
Hebrew, etc) or vice versa. It is also helpful when creating
multilingual documents.

The tool is accessible from the “Reverse Layout” tab in the
“ScribeDOOR” menu.

Pages:

You can choose to reverse the current page, the whole
document or a range of pages. You may also choose whether
or not to affect Master Items. To reverse Spreads or Island
Spreads, select the corresponding page numbers and reverse

the document binding direction.

Binding:
This option always applies to P Lo
the whole document even if Pages =
O Current —
you choose a selected range 0 Al
f O Ranges: Binding
or pages. Master: |All Master A B

By default, it is set to reverse Ohjacts Options

the binding direction (if the Filp Text Frames
Flip Frames With Graphic Content

original Document Setup is Flip Paths
Flip Objects Angles
Ieft—to—right, the blndlng [C] Flip Gradients Angles

option will be set to right-to- Graphics Options

. Flip Graphi
left and vice versa). However, e b

you can choose to reverse the

Stories Options

|Gy0Ut without chqnging the Reverse Stories Direction

[l Delete Stories Text

binding direction by selecting Change Table(s) Direction

the binding direction similar to

the set in the Document Setup.
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By applying Reverse layout on a Roman publication, you are
ready to input your Middle Eastern text with a mirrored
publication.

[The. e

Fruits

13709

The leman = the common name i Cluvs oo
Th reproductive thiue surrounds the =cod of dhe
anglosperm lemoa tree. The lamon is used for both
calinary and nonculinary purposes throughout the
world, ‘The fruit = used primasiy for its juice, though
the pulp and rind (zs57) are also used. primarily in
(uﬁngandbuhmlunmwkrhalwlﬁ%(up-

wole per lives) citric acid, which gives
hmm-mmud-pl-lof2m3.'[hhnh
lemon jaice an iasxpeasive, readily available acid for
ase in educarbonal sclence experiments. Recamse of
the an favor, many lemoa-davred drinks and can-
dies are wnallabde on the marker, including lemonade.
The lemen aad linc favons arc vawally mied ard-
Bcially and then madc in to a common carbonaed
&'hkulhhodﬂ

History

Two lemans, oae whole and one sliced in halflhe
et crigin of the lemon hes remained & myscery,
though it is widely presumed that lemons £15z grew
n Tndlts, northem Barma, and China [1][2] Tn Seuch
and Soudy Fast Asla, ic was known for foy anrdseprc
proportkcs and it wes wecd as an ascidot for veclow
ooisons. It was bstor introduced to Porsia and then

firxt recoeded in Heerarere in
a tenth century Arabic mea-
e on farming, and was also
% sl as s ormmental plant
in exdy Lilamic gardens (1]
(2] 1t was distributed widehy

throughou the Arab world and the Meditermnesn
region betwom AD 1000 and AD 1150,

Pidded lemons, + Maroccan delicacyLemons en-
tered Harope (asar southern Iraly) no later then the
firs century AD, during the time of Ancieac Rome.
However, they were nor widely aulivared, The fust
real lermon ‘coltivation 1o Euscpe began in Genoa in
the middie of the ftcenth ceanurz[2] kt was beer
introduced to the Americas in 1493 whea Christo-
pher Colambas broaghe lemon seecs o
along hit vaysges. Spanith conquest throughour the
New Wiorld hedped spread Jernon seeds. Te was mafaly
wiad as omament and mediciac (2] [n 1700 aud larc
1800s, Letmoo werc lacremingly planted fn Horkle
and California when lemon: began to be wsed in
eooking and favoring.[3]

Tn 1747, James Linds experiments o seamen suffer-

h ing from scurvy involved adding Viamin C
" to their diets through lomon juice

The rome lemon was
orginated  from  Arabic
liman aod Perstan limoo
through Old Talian acd
Old French limone.
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Known issues

Unicode markers

Some unicode markers like :

- left-to-right embedding

- right-to-left embedding

- pop directional formatting

- left-to-right override

- right-to-left override

should be displayed as hidden characters. Instead, they are
displayed and printed as arrow. This issue is linked to InDesign

US version.

South Asian languages
We strongly recommend to use Windows with last fonts
supplied with this system to get correct results for text shaping,

ligatures, etc.

Support

If you see any issues, please contact us.
We will reply to you within 48h and we will make changes and

service improvements based on your reports.
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